Chapter 640

Confidence Intervals for One Standard Deviation Using Standard Deviation

Introduction

This routine calculates the sample size necessary to achieve a specified interval width or distance from the standard deviation to the confidence limit at a stated confidence level for a confidence interval about the standard deviation when the underlying data distribution is normal.

Caution: This procedure assumes that the standard deviation of the future sample will be the same as the standard deviation that is specified. If the standard deviation to be used in the procedure is estimated from a previous sample or represents the population standard deviation, the Confidence Intervals for One Standard Deviation with Tolerance Probability procedure should be considered. That procedure controls the probability that the width or distance from the standard deviation to the confidence limit will be less than or equal to the value specified. The Confidence Intervals for One Standard Deviation using Relative Error controls the width or distance from the standard deviation to the limit by controlling the distance as a percent of the true standard deviation.

Technical Details

For a single standard deviation from a normal distribution with unknown mean, a two-sided, 100(1 – \( \alpha \))% confidence interval is calculated by

\[
\left[ s \left( \frac{n - 1}{\chi^2_{1-\alpha/2,n-1}} \right)^{1/2} s \left( \frac{n - 1}{\chi^2_{\alpha/2,n-1}} \right)^{1/2} \right]
\]

A one-sided 100(1 – \( \alpha \))% upper confidence limit is calculated by

\[
s \left( \frac{n - 1}{\chi^2_{\alpha,n-1}} \right)^{1/2}
\]
Similarly, the one-sided 100(1 – \( \alpha \))% lower confidence limit is

\[
\frac{n - 1}{\chi^2_{1-\alpha, n-1}} \sqrt{\frac{1}{n}}
\]

For two-sided intervals, the distance from the standard deviation to each of the limits is different. Thus, instead of specifying the distance to the limits we specify the width of the interval, \( W \).

The basic equation for determining sample size for a two-sided interval when \( W \) has been specified is

\[
W = s \left( \frac{n - 1}{\chi^2_{\alpha/2, n-1}} \right)^{1/2} - s \left( \frac{n - 1}{\chi^2_{1-\alpha/2, n-1}} \right)^{1/2}
\]

For one-sided intervals, the distance from the standard deviation to limits, \( D \), is specified.

The basic equation for determining sample size for a one-sided upper limit when \( D \) has been specified is

\[
D = s \left( \frac{n - 1}{\chi^2_{\alpha/2, n-1}} \right)^{1/2} - s
\]

The basic equation for determining sample size for a one-sided lower limit when \( D \) has been specified is

\[
D = s - s \left( \frac{n - 1}{\chi^2_{1-\alpha/2, n-1}} \right)^{1/2}
\]

These equations can be solved for any of the unknown quantities in terms of the others.

**Confidence Level**

The confidence level, 1 – \( \alpha \), has the following interpretation. If thousands of samples of \( n \) items are drawn from a population using simple random sampling and a confidence interval is calculated for each sample, the proportion of those intervals that will include the true population standard deviation is 1 – \( \alpha \).

**Procedure Options**

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

**Design Tab**

The Design tab contains most of the parameters and options that you will be concerned with.

**Solve For**

**Solve For**

This option specifies the parameter to be solved for from the other parameters.
One-Sided or Two-Sided Interval

Interval Type
Specify whether the interval to be used will be a two-sided confidence interval, an interval that has only an upper limit, or an interval that has only a lower limit.

Confidence

Confidence Level
The confidence level, $1 - \alpha$, has the following interpretation. If thousands of samples of $n$ items are drawn from a population using simple random sampling and a confidence interval is calculated for each sample, the proportion of those intervals that will include the true population standard deviation is $1 - \alpha$.

Often, the values 0.95 or 0.99 are used. You can enter single values or a range of values such as 0.90, 0.95 or 0.90 to 0.99 by 0.01.

Sample Size

N (Sample Size)
Enter one or more values for the sample size. This is the number of individuals selected at random from the population to be in the study.

You can enter a single value or a range of values.

Precision

Confidence Interval Width (Two-Sided)
This is the distance from the lower confidence limit to the upper confidence limit. The distance from the standard deviation to the lower and upper limits is not equal.

You can enter a single value or a list of values. The value(s) must be greater than zero.

Distance from SD to Limit (One-Sided)
This is the distance from the standard deviation to the lower or upper limit of the confidence interval, depending on whether the Interval Type is set to Lower Limit or Upper Limit.

You can enter a single value or a list of values. The value(s) must be greater than zero.

Standard Deviation

S (Standard Deviation)
Enter an estimate of the standard deviation (must be positive). The sample size and width calculations assume that the value entered here is the standard deviation estimate that is obtained from the sample. If the sample standard deviation is different from the one specified here, the width may be narrower or wider than specified.

For controlling the probability that the width is less than the value specified, see the procedure 'Confidence Intervals for One Standard Deviation with Tolerance Probability'.

For confidence intervals with widths that are specified in terms of a percentage of relative error, see the procedure 'Confidence Intervals for One Standard Deviation using Relative Error'.

One common method for estimating the standard deviation is the range divided by 4, 5, or 6.

You can enter a range of values such as 1 2 3 or 1 to 10 by 1.

Press the Standard Deviation Estimator button to load the Standard Deviation Estimator window.
Example 1 – Calculating Sample Size

Suppose a study is planned in which the researcher wishes to construct a two-sided 95% confidence interval for the standard deviation such that the width of the interval is no wider than 20 units. The confidence level is set at 0.95, but 0.99 is included for comparative purposes. The standard deviation estimate, based on the range of data values, is 34. Instead of examining only the interval width of 20, a series of widths from 16 to 24 will also be considered.

The goal is to determine the necessary sample size.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Confidence Intervals for One Standard Deviation using Standard Deviation procedure window by expanding Variances, then clicking on One Standard Deviation, and then clicking on Confidence Intervals for One Standard Deviation using Standard Deviation. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Interval Type</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Confidence Level</td>
<td>0.95 0.99</td>
</tr>
<tr>
<td>Confidence Interval Width</td>
<td>16 to 24 by 1</td>
</tr>
<tr>
<td>S (Standard Deviation)</td>
<td>34</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Confidence Level</th>
<th>Sample Size (N)</th>
<th>Target Width</th>
<th>Actual Width</th>
<th>Standard Deviation (S)</th>
<th>Lower Limit</th>
<th>Upper Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.950</td>
<td>40</td>
<td>16.000</td>
<td>15.806</td>
<td>34.000</td>
<td>27.851</td>
<td>43.657</td>
</tr>
<tr>
<td>0.950</td>
<td>67</td>
<td>17.000</td>
<td>16.774</td>
<td>34.000</td>
<td>27.715</td>
<td>44.351</td>
</tr>
<tr>
<td>0.950</td>
<td>36</td>
<td>17.000</td>
<td>16.870</td>
<td>34.000</td>
<td>27.420</td>
<td>44.289</td>
</tr>
<tr>
<td>0.950</td>
<td>60</td>
<td>18.000</td>
<td>17.891</td>
<td>34.000</td>
<td>27.258</td>
<td>45.202</td>
</tr>
<tr>
<td>0.950</td>
<td>32</td>
<td>19.000</td>
<td>18.900</td>
<td>34.000</td>
<td>26.850</td>
<td>45.750</td>
</tr>
<tr>
<td>0.950</td>
<td>54</td>
<td>20.000</td>
<td>19.819</td>
<td>34.000</td>
<td>26.776</td>
<td>46.595</td>
</tr>
<tr>
<td>0.950</td>
<td>49</td>
<td>20.000</td>
<td>19.842</td>
<td>34.000</td>
<td>26.599</td>
<td>46.441</td>
</tr>
<tr>
<td>0.950</td>
<td>45</td>
<td>21.000</td>
<td>20.751</td>
<td>34.000</td>
<td>26.548</td>
<td>47.299</td>
</tr>
<tr>
<td>0.950</td>
<td>25</td>
<td>22.000</td>
<td>20.939</td>
<td>34.000</td>
<td>26.317</td>
<td>47.256</td>
</tr>
<tr>
<td>0.950</td>
<td>38</td>
<td>22.000</td>
<td>21.827</td>
<td>34.000</td>
<td>26.295</td>
<td>48.122</td>
</tr>
<tr>
<td>0.950</td>
<td>22</td>
<td>23.000</td>
<td>22.430</td>
<td>34.000</td>
<td>26.080</td>
<td>47.972</td>
</tr>
<tr>
<td>0.950</td>
<td>35</td>
<td>23.000</td>
<td>22.986</td>
<td>34.000</td>
<td>25.818</td>
<td>48.804</td>
</tr>
<tr>
<td>0.950</td>
<td>20</td>
<td>24.000</td>
<td>23.803</td>
<td>34.000</td>
<td>25.857</td>
<td>49.659</td>
</tr>
<tr>
<td>0.950</td>
<td>33</td>
<td>24.000</td>
<td>23.813</td>
<td>34.000</td>
<td>25.627</td>
<td>49.440</td>
</tr>
</tbody>
</table>

References

Report Definitions
Confidence level is the proportion of confidence intervals (constructed with this same confidence level, sample size, etc.) that would contain the population standard deviation.
N is the size of the sample drawn from the population.
Width is distance from the lower limit to the upper limit.
Target Width is the value of the width that is entered into the procedure.
Actual Width is the value of the width that is obtained from the procedure.
Standard Deviation (S) is the assumed sample standard deviation.
Lower Limit is the lower limit of the confidence interval.
Upper Limit is the upper limit of the confidence interval.

Summary Statements
A sample size of 40 produces a two-sided 95% confidence interval with a width equal to 15.806 when the standard deviation is 34.000.

This report shows the calculated sample size for each of the scenarios.

Plots Section

These plots show the sample size versus the confidence interval width for the two confidence levels.
Example 2 – Validation using Hahn and Meeker

Hahn and Meeker (1991) page 56 give an example of a calculation for a confidence interval on the standard deviation when the confidence level is 95%, the standard deviation is 1.31, and the interval width is 2.9795. The necessary sample size is 5.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Confidence Intervals for One Standard Deviation using Standard Deviation procedure window by expanding Variances, then clicking on One Standard Deviation, and then clicking on Confidence Intervals for One Standard Deviation using Standard Deviation. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Interval Type</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Confidence Level</td>
<td>0.95</td>
</tr>
<tr>
<td>Confidence Interval Width (Two-Sided)</td>
<td>2.9795</td>
</tr>
<tr>
<td>S (Standard Deviation)</td>
<td>1.31</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

<table>
<thead>
<tr>
<th>Numeric Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confidence Level</td>
</tr>
<tr>
<td>0.950</td>
</tr>
</tbody>
</table>

PASS also calculated the necessary sample size to be 5.